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I. Introduction

A. General Description

The MS4500E-HC is a hand-held, battery powered, corrosion meter capable of measuring and storing data
from all types of electrical resistance (ER) corrosion probes. The instrument is light weight,
microprocessor-based, and features a simple, menu-driven interface using a keypad and a backlit
graphical LCD display.

Corrosion rate measurements are made using the electrical resistance method. Essentially, the instrument
measures the resistance of the probe element which changes over time, as metal loss occurs. The rate of
change is directly proportional to corrosion rate. This method finds a wide variety of applications since it
can be used in conductive and nonconductive environments such as petroleum, chemical, water, soil, or
even atmosphere. The new high-resolution measurement of the MS4500E-HC detects smaller increments
of metal loss, providing faster response than traditional ER instruments.

After taking a reading, the instrument displays metal loss in mils and corrosion rate in mils per year (mpy).
The reading can then be stored to memory or discarded. All stored readings are automatically time and
date stamped. Readings are stored to non-volatile Flash memory which retains data without the need for
a battery backup.

The MS4500E-HC High Resolution ER Data Logger can store 16,000 readings per probe on up to 250
different probes (4 million total). Stored data can be downloaded directly to a USB Flash (“jump”) drive in
non-hazardous areas. Data can be opened and charted using the provided CDMS software, or can be
imported into any standard data analysis (spreadsheet) program such as Microsoft Excel. Data can also be
reviewed and charted on the instrument’s LCD display for quick reference.

B. Principles of Operation

The MS4500E-HC High Resolution ER Data Logger operates on the Electrical Resistance (ER) technique
and is used in conjunction with an ER probe. The ER probe utilizes a resistive sensing element
manufactured from the material of interest (or a close approximation) which is exposed to a corroding
environment. This is called the Exposed or Corroding Element. The resistance of the Exposed Element
is directly related to its thickness, so as the element corrodes the resulting loss of metal causes a
proportional increase in the element’s resistance. The probe also contains an internal Reference
Element which is used to compensate for the influences of temperature on the Exposed Element.

The MS4500E-HC High Resolution ER Data Logger is designed to work with any standard ER probe,
but it is recommended that Cylindrical and Large Flush type probes be used to ensure optimum
performance. Their physical design places the Reference Element in closer proximity to the Exposed
Element compared to other probe types, providing more effective temperature compensation and
thus reducing the effects of thermal noise.



Because they are designed to corrode, ER probes are sacrificial in nature. Each ER probe will have a
finite life that is based on the element thickness. ER probes are available in a number of geometries
and thicknesses designed to suit a wide variety of applications. Table 1 lists the common ER element
options available from Metal Samples and the effective life of each.

e . Probe Life
Element Type Compatibility Thickness (Span)
b
~ 4 2
Tubular Loop Compatible
8 4
2 40 10
Wire Loop Compatible
80 20
. 4 2
\ Flush (Small) Compatible 8
20 10
> 10 5
\ Cylindrical Preferred 20 10
‘ 50 25
5 2.5
N Flush (L Preferred 10 >
ush (Large) referre 20 10
40 20

Table 1. Standard ER Probe Elements

The MS4500E-HC High Resolution ER Data Logger measures an ER probe utilizing a high-resolution, 16-
bit measurement. This allows the unit to detect much smaller amounts of metal loss, thus
responding faster to corrosion events and upsets. At 16-bit resolution the MS4500E-HC ER Data
Logger can measure metal loss amounts as small as 0.004% of the probe life. For highly sensitive
probes such as the 5-mil large flush shown above, that results in a detection limit of less than one
angstrom.



C. Technical Specifications

Model MS45000E-HC High Resolution ER Data Logger

Physical Data
Instrument Weight (w/ boot):

Total Weight w/ Case & Accessories:
Instrument Dimensions (w/ boot):
Instrument Dimensions (w/o boot):
Carrying Case Dimensions:
Operating Temperature:

Storage Temperature:

Performance Data
Measurement Type:

Range:

Resolution:
Repeatability:

Electrical Data
Power Requirements:

Maximum Probe Cable Distance:
Download Method:

2.21 Ib. (1.00 kg)

7.46 Ib. (3.38 kg)

8.75"L x 4.54"W x 2.20"D (21.77cm x 11.53cm x 5.59¢cm)
7.50"L x 4.00"W x 2.00"D (19.05cm x 10.16cm x 5.08cm)
14.50"L x 11.38"W x 5.88"D (36.83cm x 28.89cm x 14.92¢m)
-4° to 158°F (-20° to 70°C)

-40° to 158°F (-40° to 70°C)

ER measurement using any standard ER Probe Types

Preferred Probe Types: Cylindrical, Flush(Large)

Compatible probe types: Tube Loop, Wire Loop, Flush (Small)

0 - 25,000 probe life units (displayed as 0.00 to 1000.00 PLU’s in
0.04 increments)

0.004% of Probe Life

1 0.1% of Full Scale

Two 'C' size 3.6V Lithium Batteries (Xeno Energy XL-145F or
Tadiran TL4920)

200 ft. (61 m)

Non-hazardous area: Directly to USB Flash drive or to PC through
certified USB Barrier Hazardous area: Directly to certified USB
Data Transfer Unit

Hazardous Location Certifications — Intrinsic Safety

USA / Canada For use in Class | Zone 0 AEx ia [ia] IIC T4 Ga
Exia [ia] ICT4 Ga
Class I, Division 1, Groups A,B,C & D, T4
Provides outputs to Class |, Division 1 [Ex ia]
-40°C<Ta<+70°C

Europe and Worldwide 111 G Exia [ia] ICT4 Ga
(ATEX and IECEx) -40°C<Ta<+70°C
ATEX Certificate No: ITS18ATEX203161X

IECEx Certificate No: IECEx ETL 18.0007X
X — see Special Conditions (page 6)

Included Accessory Items

Carrying case, Probe Cable (1’ coiled - 6’ extended), Meter Prover, Operation Manual, Corrosion Data

Management Software, Protective Boot.

Optional Accessory Iltems

Certified Data Transfer Unit, Certified USB Barrier



Il. Start-up and Operation

A. Receiving the MS4500E-HC-HC High Resolution ER Data Logger

Check the MS4500E-HC High Resolution Data Logger for any shipping damage when it is first received.
When the unit is unpacked, verify that the following items are included:

Carrying Case
Data Logger
Meter Prover
User’s Manual
Probe Cable

In the event of shipping damage, quantity shortage, or missing items, it is recommended that the
event is documented immediately and that digital photographs are taken. Any shortages or missing
items should be reported to Metal Samples immediately. In the event of shipping damage, a claim
should be opened with the responsible carrier.

B. Start-Up

CAUTION: Using this product in any way other than that specified within this manual may impair the
intrinsic safety protection.

ATTENTION : l'utilisation de ce produit de toute autre maniére que celle spécifiée dans le présent manuel
peut altérer la protection de sécurité intrinséque.

Start-up of the MS4500E-HC High Resolution Data Logger involves the following steps:
1. Port Details and Probe Connection
2. Power-Up
3. Setup and Operation

1. Port Details and Probe Connection

ER Probe Cable Connector

USB Port.
For data transfer to—,
USB Flash Drive Only.

——

—1l

Mini USB Port
For data transfer to PC.——— — T
WARNING: For use in safe area only. :

Attention: Utilisez Seulement E
dans des endroits Sécurisés —
Auxiliary Port

Not for customer use in
current implementation.




The MS4500E-HC High Resolution Data Logger is supplied with a probe cable and it can be
connected to the probe whose metal loss value needs to be measured, no additional hardware is
necessary. Connect the probe cable ‘Lemo’ connector end to the data logger probe connector ‘J9’
available on top of the data logger. Connect the other end of the probe cable i.e. probe connector
(MS Connector) to the probe.

2. Power-Up

The unit is supplied with two (2) C type batteries installed. The instrument can be powered up by
pressing the ‘ON’ button on the Keypad . The Start-up screen with the Metal Samples logo will appear on
the screen; the start-up screen confirms the software version currently running and the SD card status.

SELECT PROBE

MAKE MEASUREMENT

RECALL READINGS

DELETE READINGS

SET TIME & DATE

SET MEASUREMENT TIMER
COMMUNICATIONS

LANGUAGE / IDIOMA / LINGUAGEM
. POWER OFF

10. BACKLIGHT ON/OFF

1.
2.
S
4.
),
6.
7.
8.
9

Version 1.7

Display Window Power On Button



a. Safe Area Usage

The MS4500E-HC High Resolution Data Logger is approved for use in hazardous areas, but can
be used in non-hazardous areas as well.

The data transfer from the unit to PC should be done in a safe area. A certified USB isolator/
Barrier should be used between the unit and PC for data transfer.

b. Hazardous Area Usage

CAUTION: This section provides general guidelines for hazardous area usage. However,
regardless of anything stated here, the MS4500E-HC High Resolution Data Logger must be used
in full compliance with the control drawing located in Appendix A and all of the local area
requirements. The entity parameters of the unit are given below.

ATTENTION : Cette section fount des directives générales pour 'utilisation en zone dangereuse
Toutefois, et indépendamment de toute déclaration faite ici, L'enregistreur de données de
haute résolution MS4500E-HC doit étre utilise en pleine conformité avec le schéma de contréle
donne en page 20 et avec toutes les exigences du locale zone dangereuse.

JO-USB Port J8 — Mini USB Port Entity Parameters):
Uo=4.94V Uo=4.94V
lo =0.332A lo =0.215A
Po=0.410W Po=0.322 W
Co=1.0uF
Lo =100 uH
SPECIAL CONDITIONS

Connection of the equipment to the ET1867 USB barrier (or any other certified barrier used with the
equipment) may only be made whilst both the barrier and the equipment are located in the non-
hazardous area.

External non-metallic materials utilize a conductive coating to prevent the risk of electrostatic charging.
The equipment shall be removed from service if damage to this coating is observed. Refer to the
manufacturer’s instruction manual for further information on the durability and any chemical vulnerability
of this coating.

CONDITIONS PARTICULIERES

e La connexion de I'équipement a la barriere USB ET1867 (ou toute autre barriere certifiée
utilisée avec I'équipement) ne doit étre effectuée que lorsque la barriére et I'équipement sont
situés dans une zone non dangereuse.

e Les matériaux externes non métalliques utilisent un revétement conducteur pour éviter le
risque de charge électrostatique. L'équipement doit étre retiré du service si des dommages a ce
revétement sont observés. Reportez-vous au manuel d'instructions du fabricant pour plus
d'informations sur la durabilité et la vulnérabilité chimique de ce revétement.



CAUTION
1. Mini USB port to transfer the data from the Data Logger to PC allowed only in safe area

through certified USB barrier.

2. Connection of the equipment to the Metal Samples # ET1867 USB barrier (or any other
certified barrier used with the equipment) may only be made while both the barrier and the
equipment are located in the non-hazardous area.

3. Only Certified USB flash drives are allowed to use in Hazardous locations.

4. Conductive coating utilized on the equipment is permanently static dissipative and humidity
independent, no further maintenance is necessary. The unit needs to be returned to

manufacturer if any damages/scratches noticed on the outer surface of the equipment.

* DO NOT USE CHEMICAL SOLVENTS TO CLEAN THE OUTER SUFRACE OF THE EQUIPMENT OR BOOT.

ATTENTION :
1. Mini port USB pour transférer les données de I'enregistreur de données au PC autorisé

uniquement dans une zone s(re grace a une barriere USB certifiée.

2. Connexion de I'équipement aux échantillons métalliques # ET1867 La barriére USB (ou toute
autre barriére certifiée utilisée avec I'équipement) ne peut étre fabriquée que si la barriére
et I'équipement sont situés dans une zone non dangereuse.

3. Seuls les lecteurs flash USB certifiés sont autorisés a utiliser dans des endroits dangereux.

4. Le revétement conducteur utilisé sur I'équipement est en permanence antistatique et
indépendant de I'humidité, aucun entretien supplémentaire n'est nécessaire. L'unité doit
étre retournée au fabricant si des dommages / rayures ont été constatés sur la surface
extérieure de I'équipement.

* N'UTILISEZ PAS DE SOLVANTS CHIMIQUES POUR NETTOYER LE SUFRACE EXTERNE DE L'EQUIPEMENT
OU DE LA BOTTE.




c. Battery Replacement

The battery compartment is located on the back of the instrument. You must first remove it to access
the battery compartment.

To replace the batteries, first loosen and remove the cover screw, then remove the battery cover to
expose the batteries. Remove the old batteries and replace them with two new 3.6V 'C' size batteries
for MS4500E-HC, being sure to follow the polarity (+/-) symbols in the battery compartment. Replace
the battery cover and cover screw.

WARNING:

Do not mix old and new batteries.

Do not mix batteries of different types (such as alkaline and lithium.)

MS4500E-HC - Xeno XL-145F / Tadiran TL4920 battery is required for intrinsic safety.

The cover screw is used to prevent unauthorized tampering of the batteries and is required to ensure
intrinsic safety.

Do not over-tighten the cover screw, as this may damage the instrument case.

ATTENTION:

Avertissement ! Ne mélangez pas des piles neuves et usées.

Avertissement ! Ne mélangez pas des piles de types différents (telles que des piles alcalines etdes
piles lithium.)

Avertissement ! MS4500E-HC La pile Xeno XL-145F / Tadiran TL4920 est requise pour la
sécurité intrinséque

Avertissement ! La vis du couvercle est utilisé pour éviter toute manipulation non autorisée des
batteries, et est nécessaire pour assurer la sécurité intrinséque.

Avertissement ! Ne pas trop serrer les vis du couvercle, pour ne pas endommager le boitier de
I'instrument




3. Setup and Operation

MAIN MENU

The MS4500E-HC allows you to measure metal loss and corrosion rate. Review this section which
describes the functions that display on the Main Menu:

SELECT PROBE

MAKE MEASUREMENT

RECALL READINGS

DELETE READINGS

SET TIME & DATE

SET MEASUREMENT TIMER
COMMUNICATIONS

LANGUAGE / IDIOMA / LINGUAGEM
. POWER OFF

10. BACKLIGHT ON/OFF

1.
2.
S
4.
S
6.
7.
8.
9

Version 1.7

Select the functions by using the up or down arrow and pressing ENTER or directly selecting the number
using the keypad and press ENTER. Pressing ‘EXIT” will return the selection to the first item of the Main
Menu.

a. Select Probe

The display will show as below if you select ‘SELECT PROBE’ menu from the main menu. You can enter a
new probe, delete a probe, or select an existing probe from this section.

B> ENTER NEW PROBE
DELETE EXISTING PROBE
1000: WIRE LOOP  PL:10.0
2500: CYLINDRICAL PL:10.0
2500: CYLINDRICAL PL:10.0
0434: TUBE LOOP  PL:10.0

PRESS ENTER TO SELECT




ENTER NEW PROBE - To enter the ID of a new probe, select ‘ENTER NEW PROBE’; the next screen
allows you to enter the ID number and the type.

1. Enter the Probe ID using the number keys. (Use the Up/Down arrows to scroll between
alphanumeric characters. Use the Right/Left arrows to advance to the next character or go back to
the previous character.) When a 4-digit Probe ID is entered the cursor automatically advances to
the Probe Type field.

2. Use the Up/Down arrows to select the Probe Type. Use the Right arrow to advance to the Probe
Life field.

3. Enter the Probe Life using the number keys.

4. Press ENTER.

PROBE ID: 5385

PROBE TYPE: WIRE 40

PROBE LIFE: 10.0

PRESS UP / DOWN ARROW TO CHANGE
PRESS ENTER TO SET

SELECT EXISTING PROBE

To assist you with selecting a probe ID, the screen displays a list of all probe IDs currently in memory.
Select from the list of probes in memory the one for which you wish to run a function (Make
Measurement, Recall Readings and Delete Readings).

ENTER NEW PROBE
DELETE EXISTING PROBE
1000: WIRE LOOP  PL:10.0
2500: CYLINDRICAL PL:10.0
2500: CYLINDRICAL PL:10.0
0434: TUBE LOOP  PL:10.0

PRESS ENTER TO SELECT

0 Pressthe arrow key to select a probe ID.
O Press ENTER.

10



DELETE EXISTING PROBE
It is occasionally necessary to remove the ID of a probe from memory, for example:
0 When the memory bank is full

0 When a probe is no longer used

To delete the ID of a probe in memory, select DELETE EXISTING PROBE.

DELETE PROBE

PROBE ID: 1000

USE UP / DOWN ARROW TO CHANGE
PRESS ENTER TO DELETE

1. Enter the probe ID - use the number keys (press the DOWN arrow if you make an error).
2. Pressthe UP arrow when you’ve entered the correct ID number.

The instrument will confirm your choice of probe ID before deleting it from memory.

11



b. Make Measurement

Select a probe before you run the function

In order for you to run ‘MAKE MEASUREMENT’ ‘RECALL READINGS’ & ‘DELETE READINGS’,
you must have already selected a probe from memory. See ‘SELECT PROBE’ from the Main
menus (page 8).

To take measurement from probes in memory, select ‘'MAKE MEASUREMENT’ menu from
the Main Menu:

SELECT PROBE

MAKE MEASUREMENT

RECALL READINGS

DELETE READINGS

SET TIME & DATE

SET MEASUREMENT TIMER
COMMUNICATIONS

LANGUAGE / IDIOMA / LINGUAGEM
. POWER OFF

10. BACKLIGHT ON/OFF

1.
2.
&,
4.
5,
6.
7.
8.
9

The next screen displays the probe ID that you selected earlier from the Main Menu item
‘SELECT PROBE .

PROBE ID:1234

PREVIOUS READING : 860.61
PROBE ID:1234 PROBE CHECK : 808.69
TUBE
READING: 860.60
MEASURING

PRESS UP ARROW TO REMEASURE
PRESS ENTER TO START PRESS ENTER TO SAVE

Press ‘ENT’ button to start measuring the probe value. During measurement ‘MEASURING..
message displays on the screen. On completion of measurement the display shows the
probe reading.
Press ‘ENT’ button to save the reading. Press ‘Up’ Arrow to re-measure the probe again.

12



¢. Recall Readings

Select ‘RECALL READINGS’ to look at data from different dates.

> ENTER NEW PROBE
DELETE EXISTING PROBE
1000: WIRE LOOP PL:10.0
2500: CYLINDRICAL PL:10.0
2500: CYLINDRICAL PL:10.0
0434: TUBE LOOP PL:10.0

PRESS ENTER TO SELECT

Select the probe if it is not already selected to look in to the readings by using up/down
arrows and press ‘ENT’ button. The readings of the selected probe will be displayed in the
next screen.

PROBE ID:1000

RDG# READING DATE(M/D/Y) TIME

8 859.60 04/24/15 18:45
759.59 04/24/15 18:45
841.60 04/24/15 18:45
459.00 04/24/15 18:45
118.00 04/24/15 18:45
434.00 04/24/15 18:45
118.00 04/24/15 18:45
456.54 04/24/15 18:45

PRESS ENTER TO GRAPH

Press ‘ENT’ button on the keypad to plot the graph of the selected probe. The graph will be
displayed on the next screen with metal loss value and corrosion rate.

PROBE ID:1000
P 1000

Of/27/15
G : 860.32

500 L:8.60

OR RATE:
.05 MPY

0 248 372
ENT = UPDATE> # OF READINGS

13



d. Delete Readings

Select ‘DELETE READINGS’ from Main Menu to erase a reading from memory.
Periodically delete readings to create more free storage area in memory.

>  ENTER NEW PROBE
DELETE EXISTING PROBE
1000: WIRE LOOP  PL:10.0
2500: CYLINDRICAL PL:10.0
2500: CYLINDRICAL PL:10.0
0434: TUBE LOOP  PL:10.0

PRESS ENTER TO SELECT

Select the probe from which the readings need to be deleted by using up/down arrows and
press ‘ENT’ button. The readings of the selected probe will be displayed in the next screen.

PROBE ID:1000
RDG# READING  DATE(M/D/Y) TIME
859.60 04/24/15 18:45
759.59 04/24/15 18:45
841.60 04/24/15 18:45
459.00 04/24/15 18:45
118.00 04/24/15 18:45
434.00 04/24/15 18:45
118.00 04/24/15 18:45
456.54 04/24/15 18:45

PRESS ENTER TO DELETE

Select the probe reading (RDG#) number which needs to be deleted by using up/down arrows
and press ‘ENT’ button. The selected probe reading will be deleted permanently from the
instrument memory.

14



e.

Set Time & Date

Select ‘SET TIME & DATE’ from Main Menu to set the internal clock of the MS4500E-
HC Data Logger. In order for information in memory to be useful and accurate, be sure
the time and date are accurate.

CAUTION: The Time and Date are set at the factory, but may need to be adjusted to your
time zone. Also, if you try to change the Date or Time and it conflicts with stored
information, the MS4500E-HC will display N/A.

ATTENTION : I'heure et la date sont définies a I'usine, mais ils peuvent étre ajustées a votre
fuseau horaire. Aussi, si vous essayez de changer la date ou I'heure et que ce ci conflit avec
'information mémorisée, le MS4500E-HC-HC affichera N/A.

DATE (MM /DD / YY):
04/27/15

TIME (HH:MM):

03: 42 PM

USE LEFT / RIGHT ARROW TO SELECT
USE UP / DOWN ARROW TO CHANGE
PRESS ENTER TO SAVE

Use the numbers on the keypad and the arrow keys to make changes to the time and date.

Press ‘/ENT’ button on the keypad to confirm your changes and return to the Main Menu , or
Press ‘EXIT’ button to discard the changes.

15



f.

Set Measurement Timer

Select ‘SET MEASUREMENT TIMER’ from Main Menu to set automatic probe
reading at set intervals. The MS4500E-HC Data Logger periodically wakes up and takes
the measurement and stores the reading.

Select a probe before you run the function
In order for you to run MAKE MIEASUREMENT, you must have already selected a probe
from memory. See Select Probe ID from the Main menus (see page 8).

> ENTER NEW PROBE
DELETE EXISTING PROBE
1000: WIRE LOOP  PL:10.0
2500: CYLINDRICAL PL:10.0
2500: CYLINDRICAL PL:10.0
0434: TUBE LOOP  PL:10.0

PRESS ENTER TO SELECT

If probe is not selected earlier, select the probe from the display. Use Up/Down arrow
keys to select the probe and press ‘ENT’ button.

DATA LOGGING INTERVAL SETUP
PROBE ID : 2500

SELECT DATA LOGGING INTERVAL:
ONCE EVERY 1 HOURS

LOGGING OFF

RIGHT / LEFT ARROW TO TURN ON/OFF
UP/DOWN ARROW TO CHANGE INTERVAL
PRESS ENTER TO SAVE

Use Right/Left arrow keys to turn on/off the data logging. Use Up/Down arrow to
change data logging interval. Minimum can be set as 1 Hours and maximum can be set
as 99 Days. The unit takes the reading once per the set interval.

16



g.

Communications

The MS4500E-HC Data Logger has the ability to store readings as they are taken. These
readings can later be transferred to your PC via USB port. To transfer data to a PCit s
necessary to install the Corrosion Data Management Software (included).

Todownload data from aninstrument:

o Connect theinstrument toan available PCUSB port.

o Turn the MS4500E-HC on.

o Run the Corrosion Data Management Software

o Openthe Instrument Download Center

° Select the serial portand instrument

o Click the Download button (ensure that Part Status toggles to “On”).

o Select ‘COMMUNICATIONS” menu from the Main Menu of the instrument.
° Select 'TRANSFER ALL" or Select the Probe data you wish to download.

B> TRANSFER ALL
1001: WIRE LOOP

PRESS ENTER TO TRANSFER

Data will begin to transfer from the instrument to the PC, and will appear in the data window of the
Instrument Download Center as shown below. If the data appears garbled, the wrong instrument
type has been selected. Select anotherinstrument type and try again.

i= g Leei P
.

Metal Samples

&= Covroddnt Moniienng Syerems

]
" Fam

Carteiion Duta Managersrd Sallw e
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If data does not appear in the data window at all, verify that:

e Theinstrumentis connected to avalid serial or USB port

e Allcablesaresecurely connected

e The message “Port Status: On” appearsin the status bar

e Therearenoerrorsontheinstrument

e [fusing a USB adapter, ensure that the device drivers have beeninstalled.

Selecting a Serial Port
When the MS4500E-HC is connected to the USB port it will appear as a virtual COM port. Use

the Serial Port selection box to select the virtual COM port number. If the COM port number is
unknown, it can be found in Windows Device Manager under “Ports (COM & LPT)".

Selecting an Instrument
Use the Instrument option box to select the model of Metal Samples instrument being downloaded.

This sets the appropriate communication parameters, which will be displayed in the status bar at the
bottom of the window (“9600,N,8,1” for an MS1500, “2400,N,8,1” for an MS3500).

Downloading Data
To toggle the selected port on and off, click the Download button. Toggling the port on and off

will also clear the data window.

Once avalid serial port and instrument have been selected, click the Download button to turn the
port on and enable the computer to receive data. If avalid serial port has been selected, the

status bar at the bottom of the window will display the message “Port Status: On”.

If aninvalid serial port has been selected, an error message will appear, and the status bar will display
the message “Port Status: Off”. If this happens, another serial port should be selected.

Saving Data
To save the data in the data window, click the Save button. The data is comma-delimited ASCII text.

It can be saved to a standard text (.txt) file, orit can be saved to a comma-separated values (.csv) file,
which greatly simplifies the process of importing the data into some spread- sheet programs such as

® ®
Excel orQuattroPro .

Printing Data
To print the contents of the data window, click the Print button. Aprint dialog box will be displayed to
allow printer selection and setup.

Charting Data

To chart the contents of the data window, click the Chart Data button. If the data has not yet been
saved, the user will be prompted to do so before the charting process begins. For more information
on charting data, see the Data Analysis section.
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DataAnalysis

The DataAnalysis utility is a convenient tool for charting data from Metal Samples ER and LPR data
loggerinstruments. The DataAnalysis utility can be opened from the Main Menu, or it can be
opened directly from the Instrument Download Center.

If the DataAnalysis utility is opened from the Instrument Download Center, the contents of the data
window will be loaded into the chart. However, if the DataAnalysis utility is opened directly from the
Main Menu, a valid data file must be loaded. The Select File box will open to allow selection of a
datafile.

Loading a DataFile
After selecting a datafile (or clicking the Chart Data button from the Instrument Download Center) a

status window will display the progress of the file being opened, along with the Instrument Type,
Probe Type, and Probe ID for the datafile.

## Opening Data File

Progress:

Instrument Type: MS1500E

Probe Type: Wire Loop
Probe ID: 1000

=

Data Table
After afile has been successfully loaded, the data will be displayed in the Data Table for review. By

default, all data points will be included in the chart. However, data points can be turned off, or
excluded, from the chart. If the “Excluded” flag appears in the status column for a data

point that data point will not appear in the chart. To toggle the exclude/ include status of a data
point, double-click the data point, or select the data point and click Exclude/Include in the Options

menu.
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Printing Data
The data table can be printed by clicking Print in the Options menu. A print dialog box will be displayed

to allow printer selection and setup.

Creating AChart
To chart the selected data, click the Chart

Data button, or select Chart Data from the
Options menu. The chart will be displayedina

Proles IT5 1680 Frabe T Wies Lasp

new window.

Printinga Chart
A chart can be printed using the Print Chart option in the File menu.

A print dialog box will be displayed to allow printer selection and setup.

Exporting a Chart

Achart can be exported to other applications using the Copy Chart option in the File menu. This will
copy both the chartand the raw data to the Windows® Clipboard. The chart can then be inserted
into other applications using the Paste function. Note: In some applications, using the Paste function
willinsert the raw data instead of the chart. In this case, use the Paste Special function, then select
Picture toinsert the chart.

ChartTools

e Statistical Data
The Statistical Data tab at the bottom of the Data Chart

window will display a page with statistical information about Fon a3
the chartdata. If the Statistical Data page is visible, this I
information can be printed by clicking Print Statistical Data
in the File menu.
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e Finding A Data Points Value
While viewing the chart, the value of any data point can be determined by simply clickingit. The value

will be displayed in the charts tool-tip box (a small text box that is displayed near the mouse pointer).
If the tool-tip box does not appear immediately after clicking the data point, hold the mouse pointer
stationary over the chart background foramoment.

e The Tools Menu

Hide Data Markers Ctil+D
Show Mean Value ClilsM
The Tools menu contains a collection of utilities for viewing and Show Trend Line CtleT
manipulating the chart. The Tools menu can be accessed by clicking ;:’gfm""“""’ L E:$
Tools on the menu bar, or by right-clicking anywhere on the chart. Data Series Color CrrlsL
Zoom In F5
Zoom Out F&
Calculate Comosion Rate F7

0 Data Markers
Show Data Markers toggles the data markers on and off.

O Mean Value
Show Mean Value toggles the mean value line on and off.

O TrendLine
Show Trend Line toggles the trend line on and off.

O Title/Footnote Setup
Title/Footnote Setup displays a window that allows the chart title and footnotes to be toggled

on and off, and to be modified.

O PlotSetup
Plot Setup displays a window that allows configuration of Y-axis scaling, and of the chart type.

The Y-axis can be scaled to default values by checking the Auto Scaling option box. The Y-axis
can be scaled to manual values by un-checking the Auto Scaling box, then entering the
desired values in the Minimum and Maximum fields.

The chart type can be set to Line Chart, Bar Chart, or Area Chart by selecting the
appropriate button in the Chart Type box. The default chart type s Line Chart.

0 Data Series Color
Data Series Color displays a color selection box, which allows the user to select the brush color

for the plotline. The default color for the plot lineis Blue.
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O Zoomin
Zoom In allows a region of the chart to be enlarged so that it may be viewed in greater detail.

To enlarge a region of the chart, click on the two data points that define the left and right
boundaries of the region.

Inzoom mode, the mouse pointer will change to a cross- hair. Whenzoom mode ends, the
mouse pointer will return to its normal state.

To cancel zoom mode, click Cancel Zoom In from the Tools menu, or simply press the Esc key.

O ZoomOut
Zoom Out restores the initial view of the chart, which displays the full data set.

O Calculate Corrosion Rate
If the chart contains ER data, the Calculate Corrosion Rate option will become available under

the Tools menu. This option allows the corrosion rate to be calculated between any two data
points on the chart. To calculate the corrosion rate click Calculate Corrosion Rate, then click
two data points. The corrosion rate between those two data points will be displayed.

In calculate mode, the mouse pointer will change to an arrow/question mark. When
calculate mode ends, the mouse pointer will return to its normal state.

To cancel a calculation, click Cancel Calculate from the Tools menu, or simply press the Esc key.
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h. Language / Idioma / Linguagem

Select ‘LANGUAGE / IDIOMA / LINGUAGEM ’ from Main Menu to select the
language.

> ENGLISH
ESPANOL
PORTUGUES
FRANCAISE

PRESS ENTER TO SELECT
PRESIONAR ENTPARA SELECCIONAR
PRESSIONAR ENT PARA AJUSTAR
TAPER ENTRER POUR REGLER

i Power Off

Select ‘POWER OFF’ from Main Menu to turn off the unit.

LOGGING OFF

j.  Backlight On/Off

Select ‘BACKLIGHT ON/OFF’ from Main Menu to turn the backlight for the LCD display
on or off.
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C. Maintenance
Once installed, the MS4500E-HC High Resolution ER Data Logger requires no maintenance. However, it
is important to verify the following items periodically to ensure continued safe operation.

CAUTION: Before performing any tests or maintenance on the MS4500E-HC High Resolution ER Data
Logger, ensure that all hazardous area requirements are met.

ATTENTION : Avant d’effectuer tout essai ou entretien de I'enregistreur de données de haute
résolution MS4500E-HC, il faut d’abord s’assurer que toutes les exigences de zone dangereuse
soient remplies.

Inspection Item Frequency
Inspect the rubber boot for any signs of damage. Replace as necessary. Annually
Inspect the probe cable / connector for any signs of damage. Replace as necessary. Annually
Replace the Batteries As needed

Contact Metal Samples for replacement parts or if instrument repair is necessary.

Testing the MS4500E-HC High Resolution ER Data Logger with the Meter Prover

A Meter Prover is provided to allow routine checks of the MS4500E-HC High Resolution ER Data Logger. The
Meter Prover simulates a Wire Loop type probe at a fixed value. To test the unit with the Meter Prover:

1) Connectthe Meter Prover to the probe connector.

2) Turn on the MS4500 data logger by pressing the ‘ON’ button

3) Select probe type as Wire Loop.

4) Select MAKE MEASUREMENT from main menu.

5) Press ‘ENT’ button to start measuring the probe value. During measurement ‘MEASURING. ‘
message displays on the screen. On completion of measurement the display shows the Meter Prover
reading. The output should closely match the value printed on the Meter Prover label.

If the Data Logger output matches the Meter Prover value, the instrument can be used for probe
measurement by selecting the appropriate PROBE ID and connecting to the respective probe. If the Data
Logger output shows a significant difference compared to the Meter Prover value, further
troubleshooting may be required. Refer to page 24 for troubleshooting or contact the factory for
further assistance.
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D. Troubleshooting

If the MS4500E-HC High Resolution ER Data Logger does not seem to perform as expected, check the
following items:

CAUTION: Before performing any tests or maintenance on the MS4500E-HC High Resolution ER Data
Logger, ensure that all hazardous area requirements are met.

ATTENTION : avant d'effectuer tout essai ou d'entretien sur I'MS4500E-HC haute résolution ER
Enregistreur de données, s'assurer que toutes les conditions sont remplies pour zone dangereuse.

1. Ensurethat the probe is operationaland is not completely corroded. This can be done in two ways.
a. Test the probe with another portable ER meter if available.
b. Test the probe with a portable resistance or continuity meter as follows:
i. Connect one test lead to pin ‘A’ of the probe’s 6-pin connector.
ii. Measure continuity to each of the other pins. There should be continuity (low
resistance) to each pin.
NOTE: Continuity on each pin does not ensure that the probe is good. However, if you
find an open circuit on any pins then it is almost certain that the probe is bad and should
be replaced.
2. Ensure the battery voltage.
3. Test the MS4500E-HC High Resolution ER Data Logger transmitter using the supplied Meter Prover
(see page 23.)

These basic checks should indicate the source of any problem (probe, power supply, wiring, etc.). If itis
determined that the MS4500E-HC High Resolution ER Data Logger is malfunctioning, or if you need
further assistance in troubleshooting, contact Metal Samples Technical Support.

CAUTION: If the MS4500E-HC High Resolution ER Data Logger transmitter shows any signs of damage,
remove it from service immediately and consult the factory.

ATTENTION: Si 'Emetteur de I’Enregistreur de données de haute résolution présente des signes de
dommages, Alors il faut le retirer du service et consulter 'usine.
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lll. Service and Warranty Information

A. Warranty

Metal Samples warrants that any part of the model MS4500E-HC High Resolution ER Data Logger and
accessories which proves to be defective in material or workmanship within one year of the date of
original shipment to Purchaser will be repaired or replaced, at Metal Samples option, free of charge. This
warranty does not cover (1) probe assemblies, (2) items expendable in nature, or (3) items subject to
damage from normal wear, misuse or abuse, or failure to follow use and care instructions.

All damaged items are to be shipped at Purchaser’s expense to and from Metal Samples which shall have
the right to final determination as to the existence and cause of a defect.

The foregoing shall constitute the sole and exclusive remedy of any purchaser of Metal Samples products
for breach of warranty and IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED OR
STATUTORY, INCLUDING THE IMPLIED WARRANTIES OR MERCHANTABILITY AND FITNESS. IN NO EVENT
SHALL METAL SAMPLES BE LIABLE FOR SPECIAL OR CONSEQUENTIAL DAMAGES, OR FOR ANY DELAY IN

THE PERFORMANCE OF THIS WARRANTY DUE TO CAUSES BEYOND ITS CONTROL.

The technical information and suggestions contained herein are believed to be reliable, but they are not to
be construed as warranties since conditions of use are beyond our control.

B. Obtaining Service and Returning the Instrument for Repair

If you experience problems with your instrument please contact the factory at 256-358-4202 and ask for
customer support for instrumentation. Our customer support department will assist you in
troubleshooting your instrument.

Most issues can be resolved over the phone, but in some cases it may be necessary to return your
instrument for further evaluation and repair. In this case, please obtain a Return Materials Authorization
(RMA) number from the sales person or support technician. This RMA number will ensure that your
instrument is routed to the correct department when it is received at the factory.

After receipt of an RMA number you may pack your instrument for return. Be sure to pack your instrument
in a sturdy box and to pad it sufficiently to avoid damage during transit. Also be sure to complete the
“Instrument Repair Form” on the next page and include a copy with your repair. This will ensure that the
repair department has sufficient information regarding the problems you are experiencing with your
instrument, as well as the billing, contact, and return shipping details for the repair.

Once you have obtained an RMA number, completed the “Instrument Repair Form”, and packed your
instrument securely, please ship it prepaid to the following address:

Metal Samples

152 Metal Samples Road
Munford, AL 36268
ATTN: RMA#

NOTE: Be sure to list your RMA number in the attention line (shown as blanks in the example above.)
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C. Instrument Repair Form
This form may be photocopied for use when returning an instrument to Metal Samples for repair.
Pleasefill in all known information and enclose a copy of the completed form with the instrument.

General Information

Model Serial
Number Number
RMA Date of
Number Purchase*
*If known.

Contact Information for Repair

Contact

Name Company
Phone E-mail
Number Address

Return Shipping Information

Recipient
Name* Company*

Return

Address

*If different than above.

Reason for Return. (Provide as much detail as possible. Attach additional pages if required.)

Invoice Instructions (For non-warranty repairs)

D Invoice me for the repair Reference
(Requires an open account with Metal samples.) PO#

D Contact me for credit card information
(For security purposes, do not list credit card information on this form..)
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Appendix B: Hazardous Area Certification Details

é Doc.Number EXDOC-000014
Metal -_— MS4500X-XX HAZARDOUS AREA CERTIFICATION - |Revision D
—n INTRINSIC SAFETY DETAILS Date 4/27/2018
Samples. 22/
PaEe 1of2
USA / Canada Class 1, Zone 0, AEx ia [ia] IC T4 Ga
Model : MS4500E-HC
-40°C = Ta<+70°C

Only with Xeno Energy XL-205F Cells and
Tadiran TL-4920 Cells

Model : MS4500E

-25°C £ Ta £ +60°C

Only with Duracell PC1500 /MN1500 Cells

Worldwide and Europe Exia[ia] ICT4 Ga
Model : MS4500E-HC
-40°C < Ta<+70°C
Only with Xeno Energy XL-205F Cells and
Tadiran TL4920 Cells
Model : MS4500E
-25°C £ Ta £ +60°C
Only with Duracell PC1500 /MN1500 Cells

ATEX Cert. No: ITS18ATEX203161X

IECEx Cert. No: IECEx ETL 18.0007X
X — See special Conditions below

Special Conditions

Connection of the equipment to the ET1867 USB barrier (or any other certified barrier used with the
equipment) may only be made whilst both the barrier and the equipment are located in the non-
hazardous area

External non-metallic materials utilize a conductive coating to prevent the risk of electrostatic
charging. The equipment shall be removed from service if damage to this coating is observed. Refer
to the manufacturer’s instruction manual for further information on the durability and any chemical
vulnerability of this coating.

Hazardous Area Installation
CAUTION : This section provides general guidelines for hazardous area wiring. However, regardless of

anything stated here, the MS4500X-XX transmitter must be installed in full compliance with the control
drawing provided Annexure-C and all of the local area requirements.




% Doc.Number EXDOC-000014
Metal == MS4500X-XX HAZARDOUS AREA CERTIFICATION - |Revision D
I v~ INTRINSIC SAFETY DETAILS Date 4/27/2018
Samples. P
age 20of2

Entity Parameters

J11: at Probe (common for all models)

Uo: 4.94v
lo: 0.332A
Po: 410mW
Ci: OuF

Li: OuH
Co: 1.0uF
Lo: 100pH

J9: USB Flash Drive [{common for all models)

Uo: 4.94v

lo: 747 5mA
Po: 923.1mW
Ci: 39.394pF
Li: 1.8uH
Co: 12.71uF
Lo: 0.37uH
J8: mini USB

Uo: 4.94v
lo: 0.215A
Po: 0.322wW

1. When replacing the battery packs in Hazardous area, discharge the static charge from
the body using ground strips or other methods.

2 Use gas analyzers or other type of equipment to ensure the area is non-hazardous before
changing the batteries. Cells in the batteries not allowed to replace in hazardous areas.

3 Use only with recommended batteries

4.  MS4500E-HCEquipment is intended for use only with Xeno Energy model XL-145F and
Tadiran TL-4920 cells. Use of any other battery in this device may impair intrinsic safety.

5. MS4500E equipment is intended for use only with Duracell PC1500/MN1500

Do not replace cells unless area is known to be Non-Hazardous.
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Appendix C: Control Drawing



Model MS4500E HC ER Data Logger

For use in dry locations.

Suitable for use in ordinary locations.
Intrinsically safe for use in the following areas:
Ex ia [ia] IIC T4 Ga

-40°C < Ta<+70°C

Class 1, Zone 0, AEx ia [ia] 1IC T4 Ga

Class 1, Division 1, Groups A,B,C,&D, T4
Provides outputs to Class 1, Division 1 [Ex ia]

Conforms to the following standards:
ANSI/UL Std. 60079-0, 60079-11 & 61010-1
Cert. to CAN/CSA 60079-0, 60079-11 &
CAN/CSA C22.2 No. 61010-1

ATEX Cert. No: ITS18ATEX203161X
IECEx Cert. No: IECEX ETL 18.0007X

The user must read and follow all instructions found in the MS4500E Users Manual.

Warning! Classification requires the use of Xeno XL-145F / Tadiran TL 4920 , size C

batteries. Use of any other battery in this device may impair intrinsic safety.

Warning! To reduce the risk of explosion do not mix old batteries with new batteries, mix batteries
from different manufacturers, or mix batteries of different types.

Warning! To reduce the risk of ignition of a flammable or explosive atmosphere, batteries must be
changed only in a location known to be non-hazardous.

Warning! Substitution of components may impair intrinsic safety.

Pour une utilisation dans des endroits secs

Convient pour une utilisation dans des lieux ordinaires.
Intrinséquement sdr pour l'usage dans les secteurs suivants:
Exia[ia] IIC T4 Ga

-40°C < Ta< +70°C

Class 1, Zone 0, AEx ia [ia] IIC T4 Ga

Class 1, Division 1, Groups A,B,C,&D, T4

Provides outputs to Class 1, Division 1 [Ex ia]

Conforme aux normes suivantes:

ANSI/UL Std. 60079-0, 60079-11 & 61010-1
Cert. to CAN/CSA 60079-0, 60079-11 &
CAN/CSA C22.2 No. 61010-1

L'utilisateur doit lire et suivre toutes les instructions dans le manuel d'utilisateur MS4500E.

Avertissement : La classification exige I'usage de Xeno XI-145F / Tadiran TL-4920 ou piles d'AA de taille.

L'usage d'aucune autre pile dans cet appareil peut diminuer la sécurité intrinséque.

Avertissement : Pour réduire le risque d'explosion ne mélange pas de vieilles piles avec les nouvelles

piles, les piles de mélange des fabricants différents, ou les piles de mélange de types différents.
Avertissement : Afin de prevenir I'inflammation d'atmospheres dangereuses, ne changer les
batteries que dans des emplacements designes non dangereux

Avertissement : La substitution de composants peut compromettre la Securite intrinseque

Note: External metallic materials are composed of <15% in total Al, Mg, Ti and Zr and <7.5% in total

Mg, Ti and Zr

THIS DOCUMENT, INCLUDING THE INFORMATION HEREIN,
SPECIALTY PRODUCTS INC. (ASPI).
BE REPRODUCED OR COPIED IN WHOLE OR IN PART. NOR MAY IT BE FURNISHED TO OTHERS
WTHOUT EXPRESS WRITTEN CONSENT FROM ASPI,
IS OR MAY BE HARMFUL TO ASPI.

© ALABAMA SPECIALTY PRODUCTS INC. 2001

IS THE PROPERTY OF ALABAMA
IT CONTAINS PROPRIETARY INFORMATION AND MAY NOT

NOR MAY IT BE USED IN ANY WAY THAT
THIS PRINT WILL BE RETURNED UPON REQUEST TO ASPI.

NON—-HAZARDOUS LOCATION
Zone non dangereuse

Note 2
Wamning! Uncertified consumer flash drives for use in safe area only.
Do not use uncertified flash drives in hazardous location.

Avertissement : les lecteurs flash non certifiés doivent etre utilisés
seulement en zone non dangereux. ne pas utiliser les lecteurs flash
dans des locations dangereuses.

2Uncertified USB flash drive ——_|

For data transfer to
USB Flash Drive Only* 2

For data transfer to
USB Flash Drive Only*2

USB Port

USB Port

HAZARDOUS (CLA

Zone dangereuse

SSIFIED) LOCATION

Mini USB-B port for data transfer to PC

USB A TO B Cable
Connect to PC

Certified USB Barrier
Metal Samples Part # ET1867

L

Warning! Connection Shall only be made
whilst both equipmnet and barrier located in
the non-hazardous area.

BY | CHKD

| 0 2
| \\ =
I =
ER Probe Extension Cable (Optional) 2
| /_ (Sold Separately) =
I Note 1: Maximum extension cable length*: 500 ft ( 152 m)
Waming! Only certified flash drives may be Ccable < 1.0 yF
I connected and used in the hazardous location. Lcable < 100 pH
I *Maximum cable length for intrinsic safety purposes. Functional limit
may be considerably less. Consult factory for more information.
I Avertissement : Seuls les lecteurs flash E
I certifiés peuvent étre connecté et utilisé dans WARNING! Extension cable to terminate with standard ER corrosion <
I'emplacement dangereux. probe only. Extension cable must not be connected to non-certified =
I equipment, or exit the hazardous location.
>
L
I o]
longueur maximale de cable d'extension* 152m =
| Ccable < 1.0 pF |
Lcable < 100 uH 6
I *longueur maximale de cable pour des raisons de sécurité >
I intrinséques. limite fonctionnelle peut étre beaucoup moins. Gl
I consulter l'usine pour de plus amples renseignements.
AVERTISSEMENT! céble d'extension pour connecter avec ER a la
I corrosion sonder seulement. cable d'extension ne doit pas étre
raccordé a I'équipement non certifié. cable d'extension ne doit pas
I quitter la zone dangereuse.
I =z
O]
I =i
=
[
I O
Probe Cable I
| / (6' Extended Length) o
Standard ER Corrosion Probe
I *Certified USB flash drive (Sold Separately)
| Metal Samples Part # ET1650 X\ "
— et
I <
(=
I >
| USB Port E ER Probe Cable Connector "
| For data transfer to a
i , 2 o (¥
USB Flash Drive Onlyl J11 - ER Probe Cable Connector mg
I P— Entity Parameters 4
l_ ﬂ____ Uo = 4.94V EE
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